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Power-Added Efficiency Measurement Power-Added Efficiency Measurement 
LibraryLibrary  User Manual User Manual 
The Power-Added Efficiency Measurement Library User Manual provides detailed 
descriptions of the product functionality and the step by step processes for use. 

Looking for Something Else? 

For information not found in the User Manual for your product, such as specifications 
and API reference, browse Related Information. 

Related information: 

• Power-Added Efficiency Measurement Library LabVIEW VI Reference 
• Electronically Scanned Array Characterization Reference Architecture User Manual 
• NI Hardware and Software Operating System Compatibility 
• Software and Driver Downloads 
• License Setup and Activation 
• NI Learning Center 

Power-Added Efficiency Measurement Library User Manual
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Power-Added Efficiency Measurement Power-Added Efficiency Measurement 
LibraryLibrary  Overview Overview 
The Power-Added Efficiency Measurement Library (PAEML) is a software add-on that 
includes integration of DC and RF measurement examples and programmatic APIs, 
and sub-nanosecond synchronization between PXI modules. 

The featured power-added efficiency (PAE) measurement relies on the combined use 
of PXI Source Measure Units (SMUs) and PXI Vector Signal Transceivers (VSTs) to help 
you measure the device-under-test (DUT) RF input and output power concerning the 
DC supply. 

Key Features 

Power-Added Efficiency Measurement Library has the following features and 
capabilities: 

• Simultaneously take PAE and PxdB measurements using a VST and SMU 
• Operation up to 26.5 GHz (defined by the VST system used) 
• Designed to measure PAE and PxdB for pulsed RF and pulsed power supply 
• Synchronizes the VST and SMU through the backplane, allowing fast device 

characterization 

Power-Added Efficiency Measurement Library Overview
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Power-Added Efficiency Measurement Power-Added Efficiency Measurement 
LibraryLibrary  New Features and Changes New Features and Changes 
Learn about updates, including new features and behavior changes, introduced in 
each version of Power-Added Efficiency Measurement Library. 

Discover what is new in the latest releases of Power-Added Efficiency Measurement 
Library. 

Related information: 

• Software and Driver Downloads 

Power-Added Efficiency Measurement Library 2024 Q3 
Changes 

Introduced October 2024 

New Features 

The initial version of the Power-Added Efficiency Measurement Library provides 
support for the following features: 

• Extracted the PAE API from the Pulsed RF Measurement Library into a separate 
software package, Power-Added Efficiency Measurement Library. 

• Added support for the PXIe-5842 Vector Signal Analyzer. 

Note If you cannot find new features and changes for your version, it might 
not include user-facing updates. However, your version might include non-
visible changes such as bug fixes and compatibility updates. For information 
about non-visible changes, refer to your product Release Notes. 

Power-Added Efficiency Measurement Library New Features and Changes
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Hardware Support 

The initial version of the Power-Added Efficiency Measurement Library provides 
support for the following instruments: 

• PXI-4130 
• PXIe-4137 
• PXIe-4139 
• PXIe-5831 
• PXIe-5841 
• PXIe-5842 

Power-Added Efficiency Measurement Library New Features and Changes
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System Requirements System Requirements 
Power-Added Efficiency Measurement Library has the following requirements: 

• Processor— 1 GHz 64-bit (x64) 
• RAM— 4 GB RAM 

• Screen Resolution—Minimum 1,024 × 768 
• Operating System—Any supported OS, with all available critical updates and 

service packs 

Supported Operating Systems 

Determine which versions of Power-Added Efficiency Measurement Library are 
compatible with your Windows operating system. 

Table 1. Compatibility Information for Power-Added Efficiency Measurement Library and Windows 
Operating Systems 

Software Name Supported Operating System (64-bit) 

Power-Added Efficiency Measurement Library 
2024 Q3 Windows 11/10 

Supported Application Development Environment 
Versions 

Determine which versions of NI application development environment (ADEs) are 
compatible with Power-Added Efficiency Measurement Library. 

Note Depending on the amount of data acquired and/or processed, a 
larger amount of memory may be required. 

System Requirements

© National Instruments 7



Table 2. Compatibility Information for Power-Added Efficiency Measurement Library and NI ADEs 

Power-Added Efficiency Measurement Library 
API Earliest Supported ADE Version 

API LabVIEW 2021 

InstrumentStudio Plugin InstrumentStudio 2024 Q3 

Supported Hardware 

Power-Added Efficiency Measurement Library provides support for the following 
hardware models. 

Vector Signal Transceivers (VSTs) 

• PXIe-5831—44 GHz, 1 GHz Bandwidth PXI Vector Signal Transceiver 
• PXIe-5841—6 GHz, 1 GHz Bandwidth, RF PXI Vector Signal Transceiver 
• PXIe-5842—26.5 GHz or 54 GHz, Up to 2 GHz BW, RF PXI Vector Signal Transceiver 

Source Measure Units (SMUs) 

• PXI-4130—±20 V, ±2 A DC, 40 W PXI Source Measure Unit 
• PXIe-4137—PXIe, ±200 V, ±1 A DC, ±3 A Pulsed, Up to 40 W DC, 100 fA Precision 

System PXI Source Measure Unit 
• PXIe-4139—PXIe, ±60 V, ±3 A DC, ±10 A Pulsed, 40 W DC, 100 fA Precision System PXI 

Source Measure Unit 

Hardware Requirements 

The Power-Added Efficiency Measurement Library (PAEML) provides several 
recommended hardware configurations to accomplish PAE measurements, including a 
choice between the PXIe-5831, PXIe-5841, or PXIe-5842 and the ability to use internal 
or external local oscillation (LO). 

Use PAEML to design a test system comprised of a source measurement unit (SMU) and 

Note The Power-Added Efficiency Measurement Library installation includes 
InstrumentStudio. 

System Requirements
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a combination of one or more vector signal transceivers (VSTs) for RF generation and 
analysis. Use the Power-Added Efficiency Measurement Library to customize and 
automate measurements. 

The following figure demonstrates how NI hardware is connected to perform a power-
added efficiency (PAE) measurement. 

Figure 1. Power-Added Efficiency Diagram 
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A VST is a combination of a one-port generator and a one-port analyzer with an 
onboard FPGA. A VST can simultaneously generate a stimulus and receive back the 
response from the coupled port with minimal phase noise impact due to the LO 
sharing capabilities between the transmission and receiving path. 

A source measure unit (SMU) is used to power the DUT and measure the power 
consumption. 

The Power-Added Efficiency Measurement Library system includes the following 
hardware components. 

Table 3. System Hardware Components 

Component Description and Recommendations 

PXI Chassis A PXI chassis houses the RTG system and supplies power, 

Notice A system and the surrounding environment must meet the 
requirements defined in the specifications documents for each hardware 
component. 

System Requirements
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Component Description and Recommendations 

communication, and timing/synchronization for the RTG 
functions. 

Required Model: PXIe-1095 

PXI Controller A PXI controller, installed in the same PXI chassis as the 
VST instruments, interfaces with the instrument using NI 
device drivers. 

Minimum Requirements: 16 GB/s bandwidth and 16 GB 
RAM 

Vector Signal Transceiver (VST) 
Instrument(s) 

The VST instrument. 

• PXIe-5831 
• PXIe-5841 or PXIe-5841 (with PXIe-5655) 
• PXIe-5842 (VST Only) 

Source Measure Unit (SMU) The SMU instrument. 

• PXI-4130 
• PXIe-4137 
• PXIe-4139 

System Requirements
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Component Description and Recommendations 

Cables and Accessories Cables and accessories not included in the hardware kits 
that allow connectivity to/from the instruments for 
measurements. 

Visit NI SMU Cable and Accessory Compatibility for 
more information about supported cables and 
accessories for your SMU. 

Related information: 

• PXIe-1095 Specifications 
• PXI-4130 Specifications 
• PXIe-4137 Specifications 
• PXIe-4139 Specifications 
• PXIe-5831 Specifications 
• PXIe-5841 Specifications 
• PXIe-5842 Specifications 
• NI SMU Cable and Accessory Compatibility 

Note The PXI-4130 supports Constant DC 
Stimulus and CW RF Stimulus measurements 
only, and does not support Pulsed DC Stimulus 
or Pulsed CW RF Stimulus measurement 
operations. 

System Requirements
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Theory of Operation Theory of Operation 
The Power-Added Efficiency Measurement Library helps you set up PXI modules for 
synchronous RF pulsing, DC triggering, and DUT control to measure PAE, compression 
point, and gain. 

Power-Added Efficiency 

Power-added efficiency (PAE) is a measure of how efficiently a power amplifier 
converts a DC and RF input to a higher power RF output. 

The following formula shows how PAE is calculated: 

PAE = PRFoutput − PRFinput
PDCsupply  

This calculation requires the power usage of the DC supply and the input and output 
powers on the ports of the DUT. To see how different frequency and power levels affect 
PAE, you can make several measurements across a sweep of frequencies or power 
levels. The data collected helps identify the ideal operating range of the DUT. 

Compression Point Measurement 

The compression point is the power level at which the amplifier enters a saturation 
region where the output power does not grow in proportion to the input power. In this 
scenario the proportion constant is equal to the gain of the amplifier. 

The most common compression points are the 1 dB, 2 dB, and 3 dB points (often 
written as P1dB, P2dB, and P3dB). Although a device's actual response diverges from 
the theoretical response outside the linear range, P1dB is where the ideal linear 
response and measured data diverge by 1 dB. 

The following graph shows an example of a PAE measurement with a compression 
point labeled. 

Theory of Operation

12 ni.com



Figure 1. Compression Points 
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Gain Measurement 

Gain measurement determines the difference in power between the input and output 
of the device for each frequency. The gain is defined as: 

Gain (dB) = 10 log( PRFoutput
PRFinput ) = PRFoutput (dBm) − PRFinput (dBm)

 

It is measured in the linear range of the device, and it is obtained for each frequency, 
showing the gains over frequency or the gains over input power. 

Theory of Operation
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Setting Up the PAEML System Setting Up the PAEML System 
The following topics show you how to set up the Power-Added Efficiency Measurement 
Library system for performing PAE measurements. 

1. Installing the Software 
Complete the following steps to install the Power-Added Efficiency Measurement 
Library. 

2. Connecting the Hardware for PAE Measurements 
Complete the following steps to set up your hardware to perform PAE 
measurements. 

Installing the Software Installing the Software 
Complete the following steps to install the Power-Added Efficiency Measurement 
Library. 

1. Download NI Package Manager from ni.com/support. 

2. Use the search field in Package Manager to find and install the following packages: 
◦ LabVIEW 
◦ Power-Added Efficiency Measurement Library 

Related information: 

• Software and Driver Downloads 
• Package Manager User Manual 
• License Setup and Activation 

Note Refer to the Package Manager User Manual for complete 
information about using Package Manager. 

Note Package Manager may recommend additional software by default. 
NI recommends that you accept these additional items. 

Setting Up the PAEML System
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Connecting the Hardware for PAE Measurements Connecting the Hardware for PAE Measurements 
Complete the following steps to set up your hardware to perform PAE measurements. 

Refer to the hardware requirements listed in System Requirements. Ensure all 
modules are installed in the chassis before completing the following steps. 

1. Connect the HI port of the SMU to the VDC port of the DUT. 
2. Connect the LO port of the SMU to the GND port of the DUT. 
3. Connect the RF OUT (or IF IN/OUT 0) port of the vector signal transceiver (VST) to 

the RF IN port of the DUT using an SMA cable. 
4. Connect the RF IN (or IF IN/OUT 1) port of the VST to the RF OUT port of the DUT 

using an SMA cable. 
Figure 1. Connecting for Power-Added Efficiency Measurements 
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Related reference: 

• System Requirements 

Related information: 

• PXIe-1095 User Manual 
• PXI-4130 Features 
• PXIe-4137 User Manual 
• PXIe-4139 User Manual 
• PXIe-5831 User Manual 
• PXIe-5841 User Manual 
• PXIe-5842 User Manual 

Setting Up the PAEML System
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Using the RF System Calibration Assistant for Using the RF System Calibration Assistant for 
the PAEML System the PAEML System 
Use the RF System Calibration Assistant to de-embed any test fixture between the VST 
and the DUT. RF System Calibration Assistant installs with PAEML. 

1. Launch the executable from the start menu or from the following file path on your 
machine: <Program Files>\National Instruments\RF System 
Calibration\RF System Calibration Assistant.exe. 

2. Click Start Calibration/Verification to begin calibration. 
3. When the Load Configuration dialog box opens, click Configure new calibration. 
4. Click the Resources tab and update the following controls in the Resources 

section. 
a. Change the resource type using the Power Meter Type drop-down menu. This 

causes the Power Meter Resource Name to automatically populate with the 
supported hardware for this type. 

b. Enable the Enable Power Meter Zero checkbox. 
c. Set the Signal Generator Type to NI5831 SG when using a PXIe-5831, or NIRFSG 

RF when using other hardware. 
d. Input the name of your signal generator as it appears in Measurement & 

Automation (MAX). 
e. Set the Signal Analyzer Type to NI5831 SA IQPOWER when using a PXIe-5831, 

or VST NIRFMX TXP when using other hardware. 
f. Input the name of your signal analyzer as it appears in MAX. 

g. Choose from the following options: 
▪ If you are using a VST, enable Self Calibrate Generator to calibrate both the 

hardware and the analyzer. 
▪ If you are not using a VST, enable Self Calibrate Generator and Self 

Calibrate Analyzer. 
h. Do not modify the External Path Resources section unless the external path 

resources are RF accessories such as amplifiers or switches that exist in the 

Note Before performing system-level calibration, you must independently 
calibrate each component of your test system. 

Using the RF System Calibration Assistant for the PAEML System
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system's RF path. 
i. Update the RF SG System Calibration Data XML File Path and the RF SA 

System Calibration File Path fields to select where you want to save your 
calibration results. 

j. Click Next. 
5. Click the (De-)Embedding Resource tab and define any de-embedding resource. 

Leave this section blank if you are not using this feature. 
6. Click the Generator Paths tab to define the generator path(s) that will be 

calibrated. 
a. Enter a path in the Path Name input field. 

b. Verify the source and destination port. Enter an alias in the Instrument Alias 
input field. 

c. If you are using a PXIe-5831, select the correct port in the SG Port column. 

d. Click Next. 
7. Click the Generator Calibration Settings tab to define the generator calibration 

sweep settings. 
a. Configure the Frequencies (Hz) and Powers (dBm) controls. 

Do not specify more than one power. The PRFM API doesn't support loading a 
file containing multiple powers. 

b. Click Append. If nothing is added to the table, ensure that generator path 
names were added in the Generator Paths tab. 

c. Click Next. 
8. Click the Analyzer Paths tab to define the analyzer path(s) that will be calibrated. 

a. Enter a path in the Path Name input field. 

b. Verify the source and destination port. Enter an alias in the Instrument Alias 

Note You must enter the Path Name first for other fields to 
autocomplete. 

Note If you are using a PXIe-5841, PXIe-5841 with PXIe-5655, or 
PXIe-5842, the SG Port column should not appear. However, if the 
SG Port column does appear, enter NA for the port. 

Note You must enter the Path Name first for other fields to 
autocomplete. 

Using the RF System Calibration Assistant for the PAEML System
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input field. 
c. Select an option from the Cal Tone Path Name drop-down menu. 
d. If you are using a PXIe-5831, select the correct port in the SA Port column. 

e. Click Next. 
9. Click the Analyzer Calibration Settings tab to define the analyzer's calibration 

sweep settings. 
a. Configure the Frequencies (Hz), Reference Level (dBm), and Cal Tone Power 

(dBm) controls. 
b. Click Append. If nothing is added to the table, ensure that analyzer path names 

were added in the Analyzer Paths tab. 

c. Click Next. 
10. Click Calibrate to begin the calibration you have defined. 
11. Click Yes in the window that appears if you want to save the calibration 

configurations. 
12. Once the calibration begins, follow the instructions in the user prompts. 
13. Once the calibration is complete, click File » Exit to close the RF System Calibration 

Assistant. 

Related information: 

• PXIe-5831 Specifications 
• PXIe-5841 Calibration Procedure 
• PXIe-5841 Specifications 
• PXIe-5842 Calibration Procedure 
• PXIe-5842 Specifications 

Note If you are using a PXIe-5841, PXIe-5841 with PXIe-5655, or , or 
PXIe-5842 the SA Port column should not appear. However, if the SA 
Port column does appear, input NA for the port. 

Note If using the Simulation mode, you must manually enter NA for 
the SA Path Name column in order for the simulation to function 
correctly. 

Using the RF System Calibration Assistant for the PAEML System
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Performing Measurements Using the PAE Performing Measurements Using the PAE 
Measurement Plugin Measurement Plugin 
The PAE Measurement Plugin for InstrumentStudio provides an interactive panel you 
can run to easily perform measurements that help you determine device efficiency 
performance. 

You configure the parameters specific to your DUT, signal generator, signal analyzer, 
and SMU and select the measurement configurations before running the application. 

Figure 4. PAE Measurement Plugin Interactive Panel 
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Click the Run button to run the measurement once. Click the down arrow to select Run 
or Run continuously. After clicking Run, the button becomes the Stop button. 

Performing Measurements Using the PAE Measurement Plugin

© National Instruments 19



Configuration Pane 

Use the parameters on the Configuration pane to specify the VST and SMU hardware, 
power, and measurement settings used for the PAE measurement. 

• RF—Click to open the RF Signal Generator and RF Signal Analyzer panes. Use 
these panes to select the RF signal generator settings and RF signal analyzer 
settings for your VST hardware. 

• Power—Click to open the SMU/Power Supply pane. Use this pane to select DC 
power settings required by the DUT. 

• Sweep—Click to open the Frequency Configuration and Power Configuration 
panes. Use these panes to select the frequency and power sweep options of the 
measurement sweep. 

• Time—Click to open the Time Configuration pane. Use this pane to select the DC 
power and RF signal options used to stimulate the DUT, and the RFmx/SMU 
measurement intervals for each option. 

• Trigger—Click to open the Trigger Configuration pane. Use this pane to select the 
trigger settings for the PAE measurement. 

• Measure—Click to open the Measure Configuration and Results Configuration 
panes. Use these panes to configure the compression point of measured data and 
to specify the data to show on the Display pane. 

• Debug—Click to open the Monitor Measurements pane. Use this pane to view the 
I/O power (dBm) plot, TXP trace plot, and real-time power values read from the 
PAE measurement. 

• Error—Click to open the Error Message pane. If an error occurs during 
configuration or execution, the Error Message pane displays the applicable error 
code and message, and the application automatically reverts to the last safe state. 
Correct the error and repeat any actions necessary to clear the error. Errors are 
automatically logged as a text file to \Documents\LabVIEW Data\PAE 
Measurement\System Level Errors\System Errors.txt. 

Display Pane 

The Display pane includes an upper graph, a lower graph, and a table. The information 
that displays in each area dynamically updates according to the options selected on 
the Measure pane of the Configuration pane. 

• Upper Graph—Shows the efficiency curve of acquired data. You can select the type 

Performing Measurements Using the PAE Measurement Plugin
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of curve to plot: 
• PAE—Plots PAE (%) over input power (dBm). You can select one or more 

frequency points to display. 
• PxdB—Plots the compression point measurement as the power output (dBm) 

and the power input (dBm) at the compression point defined by x value of 
PxdB over the different frequencies in Hz. Generates a vertical bar if the 
compression point cannot be located. 

• Gain over Frequency—Plots gain (dB) over frequency (Hz). 
• Lower Graph—Displays acquired data according to its configuration. You can 

configure the lower graph to plot RFmx Average Power, SMU Average Power, or 
Gain. 

• Table—Displays acquired data in tabulated form. You can configure the table to 
display PAE or PxdB data. 

Message Bar 

Displays actions or status related to the state, such as the power and frequency 
measured at a specific time of the application. 

Related information: 

• InstrumentStudio User Manual 

Taking a Measurement with the PAE Measurement Plugin 

The PAE Measurement Plugin enables you to perform power-added efficiency (PAE) 
measurements without interacting directly with the Power-Added Efficiency 
Measurement Library API. Use the plugin to determine the performance of the device 
being tested. 

Perform a system-level calibration to de-embed any test fixture between the VST and 
the DUT before beginning these steps. Refer to Using the RF System Calibration 
Assistant for the PAEML System for instructions. 
The following steps provide a common user workflow for interacting with the PAE 
Measurement Plugin. 
Related tasks: 

Performing Measurements Using the PAE Measurement Plugin
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• Using the RF System Calibration Assistant for the PAEML System 

Open the PAE Measurement Plugin 

Access the PAE measurement panel in InstrumentStudio. 

1. On the InstrumentStudio Home screen, select Manual Layout. 
2. In the Edit Layout window, locate Power-Added Efficiency (PAE) from the 

Measurements list and select Create large panel in the drop-down list. 
3. Click OK. 

Configure Hardware Settings 
Perform the following steps to configure and commit changes to your VST and SMU/
power supply with the RF and Power parameters on the Configuration pane. 

1. Click the RF parameter on the Configuration pane to access VST configuration 
settings. 

2. Configure the RF Signal Generator of your VST by defining the following settings on 
the RF Signal Generator pane. 
a. Select the device identifier you configured in the Measurement & Automation 

Explorer (MAX) using the RFSG Name drop-down menu. 
b. If your VST has more than one port on the generator side, enter the name of 

the port to use in the RFSG Port input field. If your VST has only one generator 
port, leave this field empty. 

c. To correct for gains/losses in the connection network, choose one of the 
following options in the RFSG Attenuation drop-down menu. 
▪ Select RF System Calibration and enter the file path of the generator 

calibration XML file created with the NI RF System Calibration Assistant in 
the RFSG Attenuation XML File input field, and then enter the name of the 
generator path you are using in the RFSG Attenuation Path Name input 
field. 

▪ Select Constant Attenuation and enter the amount of attenuation (in dB) 
between the DUT and the analyzer in the RFSG External Attenuation input 
field. 

▪ Select s2p File and enter the file path of the S2P file in the RFSG S2P File 
input field, and then enter the name of the analyzer path you are using in 
the RFSG Attenuation S2P Path Name input field. Enter the orientation in 
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the RFSG S-Parameters Orientation drop-down menu. 
3. Configure the RF Signal Analyzer of your VST by defining the following settings on 

the RF Signal Analyzer pane. 
a. Select the device identifier you configured in MAX using the RFmx Name drop-

down menu. 
b. If your VST has more than one port on the analyzer side, set the port name you 

want to use with the RFmx Port input field. If your VST has only one analyzer 
port, leave this field empty. 

c. Enter the bandwidth (in Hz) in the RBW input field. 

d. To correct for gains/losses in the connection network, choose one of the 
following options in the RFmx Attenuation drop-down menu. 
▪ Select RF System Calibration and enter the file path of the analyzer 

calibration XML file created with the NI RF System Calibration Assistant in 
the RFmx Attenuation XML File input field, and then enter the name of the 
analyzer path you are using in the RFmx Attenuation Path Name input 
field. 

▪ Select Constant Attenuation and enter the amount of attenuation (in dB) 
between the DUT and the analyzer in the RFmx External Attenuation input 
field. 

▪ Select s2p File and enter the file path of the S2P file in the RFmx S2P File 
input field, and then enter the name of the analyzer path you are using in 
the RFmx Attenuation S2P Path Name input field. Enter the orientation in 
the RFmx S-Parameters Orientation drop-down menu. 

4. Click the Power parameter to access SMU/Power Supply settings and define the 
following settings on the SMU/Power Supply and Pulsed DC Power panes. 
a. Select the device identifier you configured in MAX using the SMU Name drop-

down menu. 

Note The bandwidth has to take into account the value specified by 
the RFmx Measurement Interval. Both values define some form of 
averaging for the RF Power Measurement but can define different 
results. At a minimum, the RBW needs to be high enough that 
multiple samples, especially when taken during pulsed RF signals, 
and the measurement interval has to be short enough to stay on the 
same pulse. For more information about RBW, refer to Resolution 
Bandwidth in the NI RF Signal Analyzers User Manual. 
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b. Set the channel of the SMU to use for the measurement with the SMU Channel 
input field. 

c. Set the voltage level (in V) according to your DUT needs and specifications with 
the On Voltage Level input field. 

d. Set the current level (in A) according to your DUT needs and specifications with 
the On Current Limit input field. 

e. When the DC Stimulus Mode (set on the Time parameter page) is set to Pulsed, 
set the voltage level (in V) and current limit (in A) for the off portion of the DC 
pulse in the Off Voltage Level and Off Current Limit input fields. 

Related information: 

• Resolution Bandwidth 

Configure Sweep Settings 
Perform the following steps to configure the frequency and power sweep settings for 
your PAE measurement with the Sweep parameter on the Configuration pane. 

1. Click the Sweep parameter on the Configuration pane to access sweep settings. 
2. Configure a frequency sweep by defining the following settings on the Frequency 

Configuration pane. 
a. Enter the number of iteration steps between the start and end frequency of 

your sweep in the Frequency Steps input field. 
b. Enter the start and end frequencies (in Hz) of the sweep using the Tx Start 

Frequency and the Tx Stop Frequency input fields. 
c. If you expect a different frequency domain at the output of the DUT than the 

input of the DUT, disable the Make RFmx range the same as RFSG? checkbox 
to enable mixer mode. Mixer mode allows you to set different frequency value 
steps for each side of the DUT. 

3. Configure a power sweep by defining the following values on the Power 
Configuration pane. 
a. Configure the starting and stopping power (in dBm) of the sweep using the 

Initial Power and Final Power input fields. 
b. Configure the step size (in dBm) of the power sweep using the Power Step Size 

input field. 
c. Configure the expected gain (in dB) of the DUT using the Expected DUT Gain 

input field. Always set the expected gain of the DUT properly to avoid 
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overloading any device ports. 

Configure Time Settings 
Perform the following steps to configure the time settings for your PAE measurement 
with the Time parameters on the Configuration pane. 

1. Click the Time parameter on the Configuration pane to access time settings and 
define the following settings on the Time Configuration pane. 

2. Choose one of the following options for the type of DC Power and RF signal you 
want to stimulate your DUT in the Power Modes drop-down menu. 
◦ Select Constant Power and RF when you want to generate a continuous wave 

RF signal with Continuous Power. 
Figure 1. Constant Power and RF 

◦ Select Constant Power and Pulsed RF when your DUT needs constant power 
and your RF signal is pulsed. 
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Figure 1. Constant Power and Pulsed RF 

◦ Select Pulsed Power and RF when your DUT uses pulsed RF Signals and can 
operate or require Pulsed DC Power. 
Figure 1. Pulsed Power and RF 

3. Configure the measurement intervals for each option: 
a. Specify the time (in seconds) to measure the RFmx Transmission Power (TXP) 
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from the RFmx Measurement Interval input field. 
b. Specify the time (in seconds) to measure the SMU output power from the SMU 

Measurement Interval input field. 
4. When Constant Power and Pulsed RF is selected, configure the following 

additional required settings: 
a. Enter the time interval (in seconds) between pulses in the PRI input field. 
b. Enter the pulse width (in seconds) of the RF signal in the RF Pulse Width input 

field. 
5. When Pulsed Power and RF is selected, configure the following additional 

required settings: 
a. Enter the time interval (in seconds) between pulses in the PRI input field. 
b. Enter the pulse width (in seconds) of the RF signal in the RF Pulse Width input 

field. 
c. Enter the pulse width (in seconds) of the DC pulse in the DC Pulse Width input 

field. The PRI of the DC Pulse is equal to the PRI of the RF Pulse. 

Configure Trigger Settings 
Perform the following steps to configure the trigger and event settings for your PAE 
measurement with the Trigger parameter on the Configuration pane. 
Figure 1. Trigger Configuration 

Supported triggers and events are depicted in the figure and are as follows: 

• T1—A trigger generated after the SMU is in steady state. 
• T2—A trigger generated between SMU and RFSG with the ability to add delay (D1) 
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before the trigger and add delay (D2) after the trigger. D1 allows the DUT to get into 
steady state, even after the SMU is in steady state. D2 allows time to start 
generating the signal. 

• T3—A trigger generated between RFSG and RFmx when the signal generation 
started. The delay (D3) allows time for the DUT to get into the RF steady state 
before performing the measurement. 

1. Click the Trigger parameter on the Configuration pane to access trigger settings on 
the Trigger Configuration pane. 

2. Click the SMU to RFSG tab to configure the trigger settings that synchronize the RF 
signal to the DC power. 
a. Select the source of the trigger that starts each DC pulse using the DCPower 

Pulse Trigger Input Terminal input field. An empty string indicates no trigger is 
used and the SMU generates each pulse based on the configured PRI. 

b. Enter the time (in seconds) between the start of the DC pulse and when the 
SMU exports the source complete event using the DCPower Source Delay (D1) 
input field. 

c. Enter the time (in seconds) between when RFSG receives the pulse trigger and 
when it starts generating the pulse using the RFSG Pulse Trigger Delay (D2) 
input field. 

d. Choose the trigger routing method in the SMU to RFSG Routing Mode drop-
down list. Select from the following options. 
▪ Select Automatic to use dynamic routing to set the DCPower Source 

Complete event as the input to the RFSG Pulse Trigger using an available 
PXI backplane trigger line when in Pulsed DC stimulus mode and to use no 
trigger when in constant DC stimulus mode. 

▪ Select Manual to choose where the DCPower source complete event is 
routed to using the DCPower Source Complete Event Out Terminal input 
field, and to choose where the RFSG pulse trigger is sourced from using the 
RFSG Pulse Trigger In Terminal input field. An empty string indicates to 
not export the event or to not use the trigger. The RFSG Pulse Trigger In 
Terminal is ignored if the RF stimulus mode is set to CW. 

3. Click the RFSG to RFmx tab to configure the trigger settings that synchronize the 
RF measurement to the RF generation. 
a. Select the time (in seconds) between RFmx receiving a trigger input and the 

Note The stimulus mode is set on the Time Configuration pane. 
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start of the RFmx measurement using the RFmx Trigger Delay (D3) input field. 
b. Choose one of the following options for the trigger routing method in the RFSG 

to RFmx Routing Mode drop-down menu. 
▪ Select Automatic to use dynamic routing to set the RFSG pulse trigger as 

the input to the RFmx Trigger using an available PXI backplane trigger line 
when in Pulsed CW stimulus mode. No trigger is used in CW stimulus mode. 

▪ Select Manual to choose where the DCPower source complete event is 
routed to using the DCPower Source Complete Event Out Terminal input 
field. 
▪ Choose where the RFSG pulse trigger is sourced from using the RFSG 

Pulse Trigger In Terminal input field. An empty string indicates to not 
export the event or to not use the trigger. The RFSG Pulse Trigger In 
Terminal is ignored if the RF stimulus mode is set to CW. 

▪ Specify the input terminal for the digital edge trigger in the RFmx 
Reference Trigger Input Terminal drop-down menu. An empty string 
indicates no trigger is used. 

▪ Specify where to export the pulse trigger in the RFSG Pulse Trigger 
Output Terminal drop-down menu. 

▪ Choose the type of trigger exported from RFSG using the RFSG Trigger 
Type drop-down menu. Select Pulse to export a pulse trigger from 
RFSG at the start of each RF pulse. Select Gate to export a gate trigger 
around the RF Pulse. Set how long the gate is high before the RF pulse 
using the RFSG Pre-Trigger Time input field. Set how long (in seconds) 
the gate remains high after the RF pulse using the RFSG Post-Trigger 
Time input field. 

4. Click the RFmx to SMU tab to configure the trigger settings that synchronize the DC 
measurement to the RF measurement. 
◦ Choose one of the following options for the trigger routing method in the 

RFmx to DCPower Routing Mode drop-down menu. 
▪ Select Automatic to use dynamic routing to set the RFmx reference trigger 

as the input to the DCPower measure trigger using an available PXI 
backplane trigger line when in Pulsed CW stimulus mode and to use no 
trigger when in CW stimulus mode. 

▪ Select Manual to choose where the RFmx reference trigger is exported to 
using the RFmx Reference Trigger Output Terminal input field and to 
choose where DCPower measure trigger is sourced from using the 
DCPower Measure Trigger Input Terminal input field. An empty string 
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indicates no trigger is used. 

Configure Measure Settings 
Perform the following steps to configure compression point measurement settings and 
to select what data to display on the Display Pane with the Measure parameter on the 
Configuration pane. 

1. Click the Measure parameter on the Configuration pane to access measurement 
settings. 

2. Select the compression point measurement settings on the Measure 
Configuration pane. 
a. Set the compression point you are looking for using the x Value of PxdB input 

field. Specify 1 to measure P1db. 
b. Set the maximum linear range (in dBm) of the DUT input power using the Max 

Linear Range input field. Refer to the specifications of the DUT for this 
information. 

3. Select the data to display using the options on the Results Configuration pane. 
◦ Select the configuration to display the efficiency curve of acquired data in the 

Upper Graph Configuration drop-down menu. Select PAE, PxdB, or Gain over 
Frequency. 

◦ Select the configuration to display the secondary measurement data in the 
Lower Graph Configuration drop-down menu. Select RFmx Average Power, 
SMU Average Power, or Gain. 

◦ Select the configuration to display the acquired data in tabulated form in the 
Table Configuration drop-down menu. Select PAE or PxdB. 

Connect to the Instrument and Start Measurements 
Perform the following steps. 

1. Click the Run button or select and then click the Run Continuously button to begin 
the measurement. 

2. Click the Stop button to stop the measurement. 
3. Close the project tab or use File » Exit to exit the application. 
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Accessing Accessing Power-Added Efficiency Power-Added Efficiency 
Measurement LibraryMeasurement Library  API API 
The Power-Added Efficiency Measurement Library includes a LabVIEW API, and a C 
library and header files for use in C and other text-based programming languages. 

LabVIEW API 

The Power-Added Efficiency Measurement Library VIs are available on the 
Measurement I/O palette in LabVIEW. 

C API 

The Power-Added Efficiency Measurement Library C API header files, import libraries, 
and DLL are available in the <Program Files>\National Instruments\
PAEML directory. 

Related information: 

• Power-Added Efficiency Measurement Library LabVIEW VI Reference 

PAEML Example Locations 

The Power-Added Efficiency Measurement Library installs LabVIEW API programming 
examples that you can modify to automate and customize measurements to 
determine device performance. 

Use the NI Example Finder to locate examples within LabVIEW. 

1. Select Help » Find Examples. 
2. Click Directory Structure on the Browse tab. 
3. Double-click the niPAEML folder to expand the examples. 

You can modify an example VI to fit an application, or copy and paste from one or more 
examples into a VI that you create. 
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Related Documentation Related Documentation 
You can find the most up-to-date documentation for your NI products online on 
ni.com/docs. 

Software Documentation 

Refer to the following documentation for information about how to install, configure, 
and use the software for your system. 

Related information: 

• Power-Added Efficiency Measurement Library LabVIEW VI Reference 
• Electronically Scanned Array Characterization Reference Architecture User Manual 
• LabVIEW User Manual 
• InstrumentStudio User Manual 

PAE Measurement Hardware Documentation 

Refer to the following documentation for information about hardware components 
used for power-added efficiency measurements: 

• How to install and configure hardware 
• How to use hardware 
• Specifications 

Related information: 

• PXIe-1095 User Manual 
• PXIe-1095 Specifications 
• PXI-4130 Features 
• PXI-4130 Specifications 
• PXIe-4137 User Manual 
• PXIe-4137 Specifications 
• PXIe-4139 User Manual 
• PXIe-4139 Specifications 
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• PXIe-5831 User Manual 
• PXIe-5831 Specifications 
• PXIe-5841 User Manual 
• PXIe-5841 Specifications 
• PXIe-5841 Calibration Procedure 
• PXIe-5842 User Manual 
• PXIe-5842 Specifications 
• PXIe-5842 Configuration Guide 
• PXIe-5842 Calibration Procedure 
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